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Preface

This guide provides step-by-step procedures to help you install, deinstall, and 
upgrade Oracle Fail Safe.

Intended Audience
This guide is intended for anyone who needs to perform the initial setup and 
installation of Oracle Fail Safe on Windows systems.

In general, this book defines technical terms and concepts when they are 
introduced. However, it assumes that you know the underlying operating system 
and are familiar with basic system administration tasks. Also, you should be 
familiar with Microsoft Cluster Server (MSCS).

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/



xii

Structure
This guide contains five chapters, three appendixes, and an index:

Chapter 1
This chapter explains the process of setting up and installing Oracle Fail Safe 
software. 

Chapter 2
This chapter provides step-by-step instructions for installing Oracle Fail Safe 
software.

Chapter 3
This chapter describes how to start Oracle Fail Safe Manager and connect to a 
cluster.

Chapter 4
This chapter describes how to deinstall Oracle Fail Safe software.

Chapter 5
This chapter helps you to diagnose and troubleshoot problems that might occur 
during installations and deinstallations.

Appendix A
This appendix describes how to perform a rolling upgrade to install Oracle Fail Safe 
and other Oracle software while maintaining a highly available environment.

Appendix B
This appendix describes how to automate the Oracle Fail Safe installation by 
performing a silent installation.

Appendix C
This appendix describes how to manually register and unregister the Oracle 
resource DLL files with the MSCS software.



xiii

Related Documents
In addition to this installation guide, the Oracle Fail Safe documentation set 
includes the following:

■ Oracle Fail Safe Release Notes

■ Oracle Fail Safe Concepts and Administration Guide

■ Oracle Services for MSCS Error Messages

■ For online assistance, Oracle Fail Safe Manager provides a tutorial, online help 
topics, and a quick tour. To access the tutorial and online help topics, click Help 
on the menu bar of the main Oracle Fail Safe Manager window. To access the 
quick tour, click Start on the Windows desktop, then choose Programs, 
Oracle-<Oracle_Home>, then Oracle Fail Safe Quick Tour.

Refer to the following documentation for information about related products:

■ For more information about cluster systems, see the Microsoft Cluster Server 
(MSCS) documentation.

■ For more information about ODBC, see the Oracle ODBC documentation. Also, 
see the Oracle ODBC online Help file, which provides information specific to 
the Oracle implementation of the ODBC driver. (For example, it describes how 
to set up failover support.)

For more information about other related products, see the documentation for those 
products.

Conventions
This guide uses the conventions shown in the following table:

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted.

boldface text Boldface type in text indicates a screen prompt, menu selection, 
button, or value to be filled in.



xiv

Documentation Sales
Online product documentation is shipped with each Oracle software order. This 
documentation can be found on the Oracle Fail Safe and Oracle Real Application 
Clusters Guard software media.

Printed documentation is available for sale in the Oracle Store at:

http://oraclestore.oracle.com/

italics Italics are used to indicate technical terms when they are first 
mentioned.

Menu -> Option
-> Submenu Option

The right arrow indicates an abbreviated instruction for choosing 
a menu option or submenu option. The following example means 
pull down the View menu, move the pointer to pull down the 
Image submenu, and choose the Refresh option:

Choose View -> Image -> Refresh

monospace text File names, directories, and URLs appear in a monospace font. 
Also, monospace characters in text preceding a code example 
indicate a file name or keyword used in the sample code. 

Convention Meaning
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1
Introduction and Preinstallation Checklist

This guide uses a step-by-step approach to assist you with the installation of Oracle 
Fail Safe. Oracle Fail Safe comprises multiple components: Oracle Fail Safe 
Manager, Oracle Services for MSCS, and server components specific to Oracle Fail 
Safe. 

Oracle Fail Safe Manager is a graphical user interface through which you configure 
and manage Oracle single-instance databases, Oracle Reports, Oracle Forms and so 
on for high availability in an MSCS cluster. Oracle Services for MSCS is the main 
server component. Both the manager and the server are shared with Oracle Real 
Application Clusters Guard. For this reason, you are asked early in the installation 
process if you want to install Oracle Fail Safe or Oracle Real Application Clusters 
Guard.

Typically, you will perform your installation using the Oracle Universal Installer 
graphical user interface. If you need to perform the same installation on multiple 
systems, you may want to run Oracle Universal Installer in silent mode to automate 
the installation process in batch files or scripts. Silent installations are described in 
Appendix B.

The following topics are discussed in this chapter:

Topic Reference

Conventions Section 1.1

Cluster Setup Prerequisites Section 1.2

Recommended Order for Software Installation Section 1.3

Adding a Node to an Existing Cluster Section 1.4

Postinstallation Procedures Section 1.5
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1.1 Conventions
Screen captures that were taken during an Oracle Fail Safe installation, 
configuration, and deployment effort form the basis for this guide. The screens and 
dialog boxes represent valid choices made during an actual installation of Oracle 
Fail Safe.

1.2 Cluster Setup Prerequisites
You should perform the following configuration tasks prior to the installation of 
Oracle Fail Safe:

■ Ensure that you have a cluster hardware configuration listed on the Microsoft 
hardware compatibility list for Windows clusters.

■ Ensure that each system supports TCP/IP.

■ Check that each system has the proper Oracle Net tnsnames.ora configuration 
to allow the system to connect to its local database (if applicable) and the 
databases on the other systems.

■ If you will be installing Oracle Services for MSCS on a subset of the nodes in the 
cluster, the Cluster Group must be running on one of the nodes where you 
install Oracle Fail Safe. You can view or change the location of the Cluster 
Group using MSCS Cluster Administrator.

1.3 Recommended Order for Software Installation
Although this guide describes the Oracle Fail Safe installation in detail, other 
products also must be installed to implement your Oracle Fail Safe environment. 
Figure 1–1 shows the recommended order for installing software on a two-node 
cluster (note that the numbers in the figure do not correspond to the numbered 
steps in the subsequent list because the list contains more detailed information than 
the figure).

Note: Keep the shared storage devices powered off during all 
preliminary setup procedures. Until you install Microsoft Cluster 
Server, there is no reliable way to coordinate access to the shared 
storage devices.
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Figure 1–1 Recommended Order for Installing Software on a Two-Node Cluster

The following list provides more detail about the installation order and other tasks 
to help you get started with Oracle Fail Safe:

1. On each cluster node, install:

a. Microsoft Windows on a private (system) disk.

b. Microsoft Cluster Server (MSCS) on a private disk if you installed Microsoft 
Windows NT in step a. (MSCS is included in a Windows 2000 installation.)

See the Oracle Fail Safe Release Notes for information about the versions of 
Microsoft Windows that can be used with Oracle Fail Safe and for a link to the 
Oracle Fail Safe Web site. The Oracle Fail Safe Web site contains more 
information about installing Microsoft Cluster Server.

2. On each cluster node, test the TCP/IP connections using the Windows ping 
command.

To validate that the IP addresses and host names resolve properly across the 
cluster, perform the following tests to ensure that pinging returns the same 
address on each node:

a. Ping Node 1 on each node.

b. Ping Node 2 on each node, then Node 3, and so on for each cluster node.

c. Ping the cluster alias from each cluster node.

Node 1 Node 2

Step 1: 
Install or upgrade:
   Windows operating system
   MSCS
   Optional Oracle software
   

Step 3: 
Install or upgrade:
  Oracle Services for MSCS
  Oracle Fail Safe Manager

Step 2: 
Install or upgrade:
   Windows operating system
   MSCS
   Optional Oracle software
   

Step 4: 
Install or upgrade:
  Oracle Services for MSCS
  Oracle Fail Safe Manager
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See the Oracle Fail Safe Concepts and Administration Guide for more information 
about network configuration problems.

3. On each cluster node, create an Oracle home on a private disk (for example, the 
system disk) on each node for each Oracle product that you intend to install. To 
minimize downtime during future upgrades, Oracle Corporation recommends 
that you use a separate Oracle home for each major component (for example, a 
separate Oracle home each for the database, application software, and Oracle 
Fail Safe). To allow applications to fail over, ensure that the Oracle homes on 
each cluster node are named in the same way (for example, name the Oracle 
Fail Safe home on each system ofs_home, and name the database home on each 
system dbs_home).

4. Install optional Oracle software (database server, Forms and Reports Servers, 
Web servers, and other applications) that you plan to use with Oracle Fail Safe 
into the Oracle home (or homes) on each node. Place all application and 
database data, control, and log files on shared cluster disks so that they can fail 
over. 

If you are installing Oracle database server software, you can create the 
database before or after you install Oracle Fail Safe. Create the database as you 
would in a noncluster environment, including the database listener. However, 
the database must be created on a cluster disk or disks.

5. On each cluster node, install the server component of Oracle Fail Safe, Oracle 
Services for MSCS. If desired, you can install the client component, Oracle Fail 
Safe Manager, at the same time. 

See Chapter 2 for complete information about installing Oracle Fail Safe.

6. Optionally, install Oracle Fail Safe Manager on one or more client systems (for 
example, to set up additional management consoles).

Figure 1–2 indicates the software and files that should be installed on private disks 
and shared cluster disks.
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Figure 1–2 Software Installed on Private, Shared-Nothing Cluster Disks

1.4 Adding a Node to an Existing Cluster
If you want to add a node to an existing cluster, perform the following operations:

1. On the system that you want to add to the cluster, install:

a. Microsoft Windows on a private (system) disk.

b. Microsoft Cluster Server (MSCS) on a private disk if you installed Microsoft 
Windows NT in step a. (MSCS is included in a Windows 2000 installation.)

See the Oracle Fail Safe Release Notes for information about the versions of 
Microsoft Windows that can be used with Oracle Fail Safe and for a link to the 
Oracle Fail Safe Web site. The Oracle Fail Safe Web site contains more 
information about installing Microsoft Cluster Server.

The new node is now joined to the cluster.

2. On each cluster node (including the new node), test the TCP/IP connections 
using the Windows ping command.

Node 1 Node 2

Cluster Disks

Application Data
and Log Files

Private Disk Private Disk

Executable 
Application Files:
- Oracle Fail Safe
- Windows NT or Windows 2000
- MSCS
- Oracle HTTP Server
- Forms Server
- Reports Server
- Third-Party Applications
- . . . 

Executable 
Application Files:
- Oracle Fail Safe
- Windows NT or Windows 2000
- MSCS
- Oracle HTTP Server
- Forms Server
- Reports Server
- Third-Party Applications
- . . . 

- Database Data Files
- Database Control Files
- Database Log Files
- Forms (.fmx) Files 
- Reports (.rdf) Files
- Web Pages (.html)
- . . . 
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To validate that the IP addresses and host names resolve properly across the 
cluster, perform the following tests to ensure that pinging returns the same 
address on each node:

a. Ping Node 1 on each node.

b. Ping Node 2 on each node, then Node 3, and so on for each cluster node.

c. Ping the cluster alias from each cluster node.

See the Oracle Fail Safe Concepts and Administration Guide for more information 
about network configuration.

3. On the new node, install any desired optional Oracle software (database server, 
Forms and Reports Servers, Web servers, and other applications) that you plan 
to use with Oracle Fail Safe. Install executable application files in an Oracle 
home or homes located on private disks (for example, on the system disk for 
each node).

4. On the new node, install Oracle Services for MSCS (which is the server 
component of Oracle Fail Safe). You can install Oracle Fail Safe Manager at the 
same time.

1.5 Postinstallation Procedures
After you have successfully installed Oracle Fail Safe, perform the following tasks:

1. If you installed optional Oracle software, perform the following tasks:

■ Configure application data and log files on the shared cluster disks.

■ Configure alert and trace files on either the shared cluster disks or on the 
private disk.

Configuring alert and trace files on private disks allows the administrator 
to determine on which node problems occur, but requires that you maintain 
multiple sets of files. Placing parameter files on private disks is 
recommended only when you want the parameters to be different on each 
cluster node. For example, this can be useful if you want a database to use 
fewer resources on its failover node than on its primary node (such as when 
you know another application or database server on the failover node 
needs resources).

For information about re-creating Oracle databases on cluster disks, refer to 
the Import/Export documentation that is specific to your database.
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2. Start Oracle Fail Safe Manager, connect to the cluster alias with a domain 
account that has Administrator privileges on each cluster node, and run the 
Verify Cluster operation when prompted.

See Chapter 3 for information to help you get started with Oracle Fail Safe.

3. Refer to the Oracle Fail Safe tutorial for step-by-step information about creating 
a group and adding resources to it. (To invoke the tutorial from the Oracle Fail 
Safe Manager, choose Help -> Tutorial.)
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2
Installing Oracle Fail Safe

This chapter provides step-by-step instructions for installing Oracle Fail Safe 
Manager, Oracle Services for MSCS, and additional server components specific to 
Oracle Fail Safe. 

The discussions in this chapter assume that you have already set up your hardware 
configuration and installed Microsoft Windows and the corresponding version of 
Microsoft Cluster Server (MSCS). If you plan to configure Oracle products or other 
components with Oracle Fail Safe, install the component software prior to installing 
Oracle Fail Safe.

The following topics are discussed in this chapter:

2.1 Review the Before You Install Checklist
Check these conditions before beginning the installation procedure:

■ Verify the release of any other Oracle software or third-party software that you 
plan to use with Oracle Fail Safe against the software compatibility guidelines 
that are documented in the Oracle Fail Safe Release Notes.

Note: If you are upgrading to Oracle Fail Safe release 3.3.1 from 
an earlier release, see Appendix A for information about 
performing a rolling upgrade.

Procedure Reference

Review the Before You Install Checklist Section 2.1

Install the Oracle Fail Safe Software Section 2.2
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■ If necessary, install MSCS.

■ Verify that the cluster is up and running on all nodes.

■ Remove the previous version of Oracle Fail Safe, if necessary. If you need to 
deinstall Oracle Fail Safe release 2.1.3, you must use the Oracle Installer 
program located at OracleInstall\setup.exe on the Oracle Fail Safe release 3.3.1 
CD-ROM.

■ Install additional components that you want to configure with Oracle Fail Safe 
(Oracle database server, Oracle Forms, Oracle Reports, Web applications, and so 
on).

■ If necessary, install Oracle Enterprise Manager. To start Oracle Fail Safe 
Manager from within Oracle Enterprise Manager, you must install Oracle Fail 
Safe Manager after Oracle Enterprise Manager has already been installed on the 
system.

■ Plan your installation strategy for multiple Oracle homes. If you are installing 
on a system with multiple Oracle homes, refer to the documentation for the 
Oracle component to find compatibility information.

■ Log on to the cluster nodes using the same domain user account that has 
Administrator privileges. The account from which you run Oracle Universal 
Installer must have Administrator privileges.

2.2 Install the Oracle Fail Safe Software
Install Oracle Fail Safe on all cluster nodes, but perform the Oracle Services for 
MSCS installation sequentially on only one node at a time. Optionally, you can 
install Oracle Fail Safe Manager on the cluster nodes at the same time.

To install Oracle Fail Safe software on the cluster nodes, they must be running the 
following software:

■ Microsoft Windows

■ MSCS

To install Oracle Fail Safe Manager on client systems, they must be running 
Microsoft Windows. 

See the Oracle Fail Safe Release Notes for information regarding the required versions 
of Microsoft Windows and MSCS. 
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Step 1  Start Oracle Universal Installer.
Oracle Universal Installer, which is included in the Oracle Fail Safe software kit, 
must be used to install Oracle Fail Safe release 3.3.1.

Oracle Universal Installer should be invoked automatically upon inserting the 
CD-ROM. If it is not invoked, run the Oracle Fail Safe setup.exe program, which is 
on the CD-ROM.

Oracle Universal Installer automatically performs the installation procedure in the 
same language used by the operating system. For example, if the node operating 
system is in Japanese, Oracle Universal Installer automatically performs the 
installation in Japanese.

Step 2  Verify installed components and Oracle homes.
After you start Oracle Universal Installer, the Welcome window shown in 
Figure 2–1 is displayed. 

Note: If you decide to update a Windows NT service pack from 
one supported version to another, you can do so regardless of 
whether or not Oracle Fail Safe or the software for resources that 
Oracle Fail Safe supports has been installed.
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Figure 2–1 Oracle Universal Installer Welcome Window

You can optionally click Installed Products to view the Oracle components that are 
already installed and the Oracle homes where they reside.

Click Next to proceed.

Step 3  Specify the Oracle home directory for the Oracle Fail Safe installation.
In the File Locations dialog box (shown in Figure 2–2), the destination directory is 
the location where you want to install the Oracle Fail Safe software. Install Oracle 
Fail Safe on a private disk on each cluster node.
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Figure 2–2 Specifying the Oracle Home Directory

Source:  Accept the default source directory location that is supplied 
automatically by the installer. Typically, you do not need to change the directory 
location that is supplied.

Destination:  Specify a unique Oracle home name where you want to install the 
Oracle Fail Safe software. Note the following conditions:

■ Install Oracle Fail Safe on a private disk, not on a shared cluster disk.

■ Install the Oracle Fail Safe release 3.3.1 software in an Oracle home created by 
Oracle Universal Installer.

You cannot specify an Oracle home that contains components installed with 
Oracle Installer (the predecessor to Oracle Universal Installer); you must specify 
an Oracle home that was created by Oracle Universal Installer. To more easily 
upgrade to future releases of Oracle Fail Safe, Oracle Corporation recommends 
that you install Oracle Fail Safe in its own Oracle home. However, if you choose 
to also install Oracle Real Application Clusters Guard, beginning with release 
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3.3.1 it must be installed in the same home as Oracle Fail Safe. Oracle Fail Safe 
and Oracle Real Application Clusters Guard share both client and server 
components.

■ Install the Oracle Fail Safe server software (which includes Oracle Services for 
MSCS and additional Oracle Fail Safe server components) in one Oracle home, 
not in multiple Oracle homes. (Oracle Universal Installer prevents you from 
installing Oracle Fail Safe server components in more than one Oracle home.) 
The name of the Oracle home must be the same on each node in the cluster. 
Although not required, Oracle Corporation recommends that the Oracle home 
path also be the same on each cluster node.

■ In versions of Oracle Fail Safe prior to 3.1, Oracle Fail Safe Manager also could 
only be installed in one Oracle home. Starting with Oracle Fail Safe release 3.1, 
however, it is possible to have Oracle Fail Safe Manager installed in more than 
one Oracle home. It is also possible to have multiple copies of Oracle Fail Safe 
Manager in multiple Oracle homes. Because of this, you can have multiple 
versions of Oracle Fail Safe Manager installed on the same system.

Click Next.

Step 4  Select the product to install.
In the Available Products dialog box (shown in Figure 2–3), choose Oracle Fail Safe.

As mentioned earlier, Oracle Real Application Clusters Guard and Oracle Fail Safe 
share the Oracle Services for MSCS software. You use Oracle Fail Safe to configure 
and manage single-instance databases and applications for high availability 
through cold failover on Windows clusters. You use Oracle Real Application 
Clusters Guard with Oracle Real Application Clusters multiple-instance databases 
to provide high availability on Windows clusters through enhanced warm failover.

See the Oracle Real Application Clusters Guard Installation Guide for information on 
how to install Oracle Real Application Clusters Guard.
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Figure 2–3 Selecting the Product to Install

Click Next to load the installation information from the source location. The 
installer displays a Loading Product Information window that is incremented as the 
Oracle Fail Safe components are loaded.

Step 5  Select an installation type.
You can select the Typical, Client Only, or Custom or Reinstall installation option 
from the Installation Types window shown in Figure 2–4. 
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Figure 2–4 Choosing an Installation Type

Typical is the default installation type.

If you choose the Typical option, you will install Oracle Fail Safe Manager and 
Oracle Services for MSCS.

If you choose the Client Only option, you will install Oracle Fail Safe Manager.

If you choose the Custom or Reinstall option, Oracle Universal Installer displays 
the window shown in Figure 2–5. By default, Oracle Fail Safe Manager, Oracle Fail 
Safe server components, and Oracle Services for MSCS are preselected. You must 
deselect the components that you do not want to install.

The Oracle Fail Safe server components have a dependency on Oracle Services for 
MSCS. Do not deselect one and not the other. However, you can choose to install 
just the manager (by deselecting both Oracle Fail Safe server components and 
Oracle Services for MSCS) or you can choose to install just the server software (by 
deselecting Oracle Fail Safe Manager). 



Install the Oracle Fail Safe Software

Installing Oracle Fail Safe 2-9

Figure 2–5 Custom Installation Options

Installing and using sample database files: Optionally, you can install the sample 
database files when you install Oracle Fail Safe, or save disk space by leaving the 
sample database files on the CD-ROM.

■ If you select Sample Databases, the installer checks to see which database 
releases are installed on the cluster node and installs only the sample database 
files with the same release numbers, as described in the following paragraph. It 
installs the sample database files in the same Oracle home as Oracle Fail Safe.

The Oracle Fail Safe release 3.3.1 installation kit includes sample Oracle 8.0.5 
and Oracle 8.1.5 database files. Oracle Universal Installer installs one or a 
combination of these files, depending on which database versions you currently 
have installed on the server node. Thus, if only an Oracle8 database is installed 
on the node, then only Oracle 8.0.5 sample database files are installed. If the 
cluster node has Oracle8 and Oracle8i installed, then Oracle 8.0.5 and Oracle 
8.1.5 sample database files are installed to match the installed database 
configuration. If the server node has Oracle9i installed, Oracle Fail Safe issues a 
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Database Configuration Assistant (DBCA) command to create a sample 
database for you when you issue a Create Sample Database command.

■ If you do not select Sample Databases, then the installer does not install any 
sample database files.

Later, if you issue a command to create a sample Oracle 8.0.5 or Oracle 8.1.5 
database, Oracle Fail Safe checks to see if all necessary sample files are located in 
the Oracle home where you installed Oracle Fail Safe. If the sample database files 
are not in the Oracle home, Oracle Fail Safe checks to see if the Oracle Fail Safe 
release 3.3.1 CD-ROM is online. If Oracle Fail Safe finds the sample files in either the 
Oracle home or on the CD-ROM, the Create Sample Database operation will 
succeed. Otherwise, it will return an error message.

At this point, Oracle Universal Installer displays a window informing you that you 
must reboot the node at the end of the installation, as shown in Figure 2–6. (Step 10 
in these instructions provides more information about rebooting the node.) This 
window is not displayed if you have previously installed Oracle Fail Safe and the 
changes to the system path have been made and detected previously.

Note: If you are performing the installation on a node that does 
not have the MSCS software installed and you choose an 
installation type that includes Oracle Services for MSCS, an error 
message is displayed, as shown in Figure 5–1.

Click OK to exit the error message window. Click Exit to stop the 
installation.
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Figure 2–6 Reboot Needed After Installation Window

Step 6  Verify the component installations in the Summary window.
Figure 2–7 shows a Summary window that lists the components selected for this 
installation.

Verify that the information in the Summary window is correct. If the summary 
includes a component that you do not want to install, click Previous to back up 
through the installation dialog and deselect the component.

Note that the Oracle Fail Safe documentation and Oracle Fail Safe quick tour are 
installed automatically and cannot be deselected.



Install the Oracle Fail Safe Software

2-12 Oracle Fail Safe Installation Guide

Figure 2–7 Summary Window Showing Components to Be Installed

If the information in the Summary window is correct, click Install to start the 
installation.

The Install window shown in Figure 2–8 displays the progress of the installation, 
including the names of the files that are being installed.

Note: If your system has insufficient space to perform the 
installation, the text below Space Requirements is displayed in red.
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Figure 2–8 Installation Progress Window

Typically, the installation completes in 1 to 5 minutes.

Step 7  Enter a domain user account for Oracle Services for MSCS.
If the installation is successful, the Configuration Tools window and the Oracle 
Services for MSCS Account/Password dialog box shown in Figure 2–9 are 
displayed. 

In the Oracle Services for MSCS Account/Password dialog box, enter the domain, 
user name, and password of a user account that has Administrator privileges. This 
is the account that Oracle Services for MSCS will be using to access this cluster. 
Oracle Services for MSCS runs as a Windows service (called OracleMSCSServices) 
under a user account that must be a domain user account (not the system account) 
that has Administrator privileges on all nodes of this cluster. The account must be 
the same on all nodes of this cluster, or you will receive an error message when you 
attempt to connect to a cluster using Oracle Fail Safe Manager.
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You enter the information in the form Domain\Username, as shown in Figure 2–9, 
or if you are using Windows 2000, you can enter a user principal name in the form 
Username@DnsDomainName in the Domain\Username box.

Figure 2–9 Oracle Services for MSCS Security Information

Step 8  Confirm the installation.
Oracle Universal Installer displays the End of Installation window shown in 
Figure 2–10. You can confirm the installation of Oracle Fail Safe and any additional 
components by clicking Installed Products.
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Figure 2–10 End of Installation Window

Step 9  View the Oracle Fail Safe Release Notes.
Click Release Information to view the Oracle Fail Safe Release Notes.

Step 10  Reboot the cluster node if you are instructed to do so.
If a window was presented that instructed you to reboot the cluster node (as shown 
in Figure 2–6), then do so after you exit the installer.

Step 11  Verify the Oracle Fail Safe installation.
See Chapter 3 for information on verifying the Oracle Fail Safe installation.

Note: You must wait until the current node is finished rebooting 
before you start installing Oracle Fail Safe on other nodes. (Other 
nodes can be up or down when you reboot the current node.)
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3
Getting Started

This chapter contains the following topics to help you connect to a cluster and get 
started using Oracle Fail Safe Manager:

3.1 Starting the Manager and Verifying the Oracle Fail Safe Installation
After you have installed Oracle Fail Safe software on all nodes in the cluster, you 
must verify the installation.

This section describes how to start Oracle Fail Safe Manager, connect to the cluster, 
and perform the tasks involved in installation verification.

3.1.1 Start Oracle Fail Safe Manager
After the installation completes, invoke Oracle Fail Safe Manager from the 
Windows taskbar by choosing:

Start -> Programs -> Oracle - <Oracle_Home> -> Oracle Fail Safe Manager

In the example, replace <Oracle_Home> with the name of the Oracle home where 
you installed Oracle Fail Safe.

When Oracle Fail Safe Manager opens, usually the Add Cluster to Tree dialog box is 
also opened, as shown in Figure 3–1. (If the Add Cluster to Tree dialog box is not 
open, from the File menu, choose Add Cluster to Tree.) In the Cluster Alias box, 
enter the alias for the cluster and then click OK.

Topic Reference

Starting the Manager and Verifying the Oracle Fail Safe Installation Section 3.1

Oracle Fail Safe Manager Tutorial and Online Help Section 3.2
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Figure 3–1 Adding a Cluster to the Tree View

After you click OK in the Add Cluster to Tree dialog box, the cluster alias is added 
to the tree view, and the General tab for the cluster is displayed, as shown in 
Figure 3–2. However, because Oracle Fail Safe Manager is not yet connected to the 
cluster, the general tab displays the message: "Oracle Fail Safe Manager is not 
currently connected to this cluster. To connect, open the File menu, and select 
Connect to Cluster." The next section describes connecting to a cluster in detail.
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Figure 3–2 Oracle Fail Safe Manager with Cluster Added to Tree View

3.1.2 Connect to the Cluster
After you add the cluster to the tree view, you must connect to the cluster. Open the 
Connect to Cluster dialog box by doing one of the following:

■ On the File menu, click Connect to Cluster.

■ Right-click the cluster alias, then click Connect.

■ Click the box to the left of the cluster alias (to expand the cluster alias folder).

Oracle Fail Safe displays the Connect to Cluster dialog box that allows you to make 
a connection to a cluster, as shown in Figure 3–3. (Note that if both Oracle Fail Safe 
and Oracle Real Application Clusters Guard are installed on the cluster, Oracle 
Services for MSCS will open a window that asks whether you want Oracle Fail Safe 
Manager to present the Oracle Fail Safe or Oracle Real Application Clusters Guard 
view of the cluster. If you have both products installed, click Fail Safe mode.)



Starting the Manager and Verifying the Oracle Fail Safe Installation

3-4 Oracle Fail Safe Installation Guide

Figure 3–3 Connect to Cluster Dialog Box

Cluster Alias is required input; User Name, Password, and Domain are optional on 
Windows NT and required on Windows 2000. The Save as Local Preferred 
Credentials option is not a required choice on either Windows system.

The following list describes the input to the Connect to Cluster dialog box:

■ User Name

Enter a user name for a domain account name that has Administrator privileges 
on all nodes of the cluster where you are connecting.

■ Password

Enter the password for account specified in the User Name field.

■ Cluster Alias

Contains the alias of the cluster that you selected from the tree view. The alias 
name is assigned to the cluster when you (or someone else) created the cluster 
with MSCS. A cluster alias is sometimes referred to as a cluster name.

■ Domain

Enter the name of the domain to which the user name belongs.

■ Save as local preferred credentials

Note: If you do not specify a user name, password, or domain, 
Oracle Fail Safe attempts to connect to the cluster using the account 
with which you logged on to the server node.
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Select to have Oracle Fail Safe Manager save the account information you have 
entered to a text file, <Oracle_Home>\fs\fsmgr\FsClusters.txt on the system 
from which you are running Oracle Fail Safe Manager. The password is saved 
in an encrypted format. This allows you to disconnect and reconnect to the 
cluster (from your current system) without having to respecify the account 
information each time a reconnection is requested.

Click OK or press Enter to connect to the cluster.

Once you are connected to the cluster, the Oracle Fail Safe Manager main window 
expands the tree view, as shown in Figure 3–4.

Figure 3–4 Oracle Fail Safe Manager

3.1.3 Run Verify Cluster
The first time you connect to a cluster after you install Oracle Fail Safe, Oracle Fail 
Safe Manager prompts you to run the Verify Cluster operation to validate the Oracle 
Fail Safe installation and the network configuration. The Verify Cluster operation 
displays its progress in a Verifying Cluster window, as shown in Figure 3–5.
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(Later, you can run the Verify Cluster operation at any time by choosing 
Troubleshooting -> Verify Cluster from the Oracle Fail Safe Manager menu bar. 
This is especially useful if you later change your cluster configuration.)

Figure 3–5 Verify Cluster Operation Results

Verify Cluster performs operations to verify that:

■ The Oracle homes are identical on all nodes

■ The Oracle Fail Safe release is identical on all nodes

■ The resource providers are configured identically on all nodes
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■ The resource providers are disabled if the required software has not been 
installed

■ The Host Name/IP Address mappings resolve consistently across all nodes in 
the cluster

Verify Cluster also registers with MSCS the resource DLLs for the resource types 
that Oracle Fail Safe supports.

The Oracle Fail Safe Concepts and Administration Guide describes the Verify Cluster 
operation in more detail.

3.1.4 Verify the OracleMSCSServices Service Entry
Upon successful installation and verification of Oracle Services for MSCS, the 
Services Control Panel on each cluster node should include a new service entry 
named OracleMSCSServices.

 To verify the OracleMSCSServices entry in the Services Control Panel:

1. Start the Control Panel:

Start -> Settings -> Control Panel 

2. Open the Services Window: 

■ On Windows NT, double-click the Services icon on the Control Panel.

■ On Windows 2000, double-click Administrative Tools, then Services on the 
Control Panel.

3. Scroll down to the Oracle service listings and locate the OracleMSCSServices 
entry, as shown for Windows NT in Figure 3–6.

The Startup status for OracleMSCSServices is displayed as Started on the node 
where the Cluster Group resides, and it is displayed as Manual on the other 
cluster nodes.

4. Click Close to exit the Services Control Panel.

5. Perform steps 1 through 4 on each cluster node.
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Figure 3–6 Services Dialog Box on Windows NT

3.1.5 Verify That Oracle Services for MSCS Is in the Cluster Group
The Oracle Services for MSCS service is maintained by MSCS. Upon successful 
installation of the Oracle Services for MSCS on each cluster node, invoke the MSCS 
Cluster Administrator and verify that it includes Oracle Services for MSCS as a 
resource in the Cluster Group (the group containing the MSCS resources critical to 
cluster operation).

To verify that the Oracle Services for MSCS is listed as a resource, start the MSCS 
Cluster Administrator, as follows:

Start -> Programs -> Administrative Tools -> Cluster Administrator 

Click Cluster Group in the Cluster Administrator tree view to select it, and, in the 
right-hand pane, locate the Oracle Services for MSCS entry in the Name column, 
as shown in Figure 3–7.
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Figure 3–7 Oracle Services for MSCS in the Cluster Administrator Window

3.1.6 Verify That Oracle Resource DLLs Were Registered with MSCS
After installing Oracle Services for MSCS on all cluster nodes and verifying the 
cluster, invoke the MSCS Cluster Administrator and verify that it includes the 
cluster resource types for Oracle Fail Safe.

For example, if you have the Oracle database server installed on your cluster nodes, 
start the MSCS Cluster Administrator, as follows:

Start -> Programs -> Administrative Tools -> Cluster Administrator 

Select Resource Types in the Cluster Administrator tree view, and, in the right-hand 
pane, locate the Oracle Database and Oracle TNS Listener entries in the Display 
Name column, as shown in Figure 3–8.
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Figure 3–8 Oracle Database and Listener in the Cluster Administrator Window

3.2 Oracle Fail Safe Manager Tutorial and Online Help
For detailed step-by-step instructions about using Oracle Fail Safe Manager, refer to 
the Oracle Fail Safe tutorial and help. To access these online tools, from the Oracle 
Fail Safe Manager menu bar, choose Help -> Contents or Help -> Tutorial for 
step-by-step instructions, as shown in Figure 3–9.

Figure 3–9 Help Menu

The online help is your primary source of information when you use Oracle Fail 
Safe Manager. For example, if you select Contents in the Help menu, the Help 
window displays the first help topic. If you select Search for Help on, a Help 
window opens to display Contents, Index, and Find tabs (similar to what you find 
in Microsoft Windows Help). You can find common tasks under the Contents tab 
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and in the Index. The Find tab allows you to perform a full text search of the Oracle 
Fail Safe Manager Help.

The help contains topics for both Oracle Fail Safe users and Oracle Real Application 
Clusters Guard users. The following conventions are used to differentiate among 
topics specific to one or the other software program: 

■ Topics that are specific to Oracle Fail Safe contain the phrase "Fail Safe mode" in 
the help topic title.

■ Topics that are specific to Oracle Real Application Clusters Guard contain the 
phrase "Real Application Clusters Guard mode" in the help topic title. 

■ Topics that apply to both software programs have no reference to Fail Safe or 
Real Application Clusters Guard in the help topic title.

To view the full set of Oracle Fail Safe documentation, select Online Manuals.

In addition, first-time users might want to browse through the online quick tour, 
which provides an easy-to-follow overview of Windows clusters and the ways you 
can deploy highly available business solutions with Oracle Fail Safe. You can access 
the quick tour from the Windows taskbar after you have installed Oracle Fail Safe. 
Choose: Start -> Programs -> Oracle - <Oracle_Home> -> Oracle Fail Safe Quick 
Tour.
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4
Deinstalling Software on a Cluster

This chapter contains the following topics to help you deinstall Oracle Fail Safe:

You might want to deinstall Oracle Fail Safe, for example, to remove older software 
such as Oracle Fail Safe release 2.1.3, or to move Oracle Fail Safe software to another 
Oracle home. However, do not use the deinstallation instructions in this chapter as a 
method for upgrading the Oracle Fail Safe software to release 3.3.1. See Appendix A 
for information about performing a rolling upgrade.

4.1 Deinstalling Oracle Fail Safe Release 3.n Software
Deinstalling Oracle Fail Safe software involves removing resources from groups and 
reconfiguring them to run on a specific cluster node.

Topic Reference

Deinstalling Oracle Fail Safe Release 3.n Software Section 4.1

Deinstalling Oracle Fail Safe Release 2.n Software Section 4.2

Caution: Do not remove the Microsoft Cluster Server (MSCS) 
software without first deinstalling Oracle Fail Safe. Removing the 
MSCS software while Oracle Fail Safe is running will cause all 
MSCS metadata to be deleted, producing undesirable results. See 
Section 5.4 for more information.
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Step 1  Remove cluster resources from groups configured with Oracle Fail 
Safe Manager.
This step should be done only on groups that were configured with Oracle Fail Safe. 
Do not perform this step on groups that were configured with MSCS (such as the 
Cluster Group).

Using Oracle Fail Safe Manager, perform the following tasks:

1. Move each group to the node that will host the standalone resources after 
Oracle Fail Safe is deinstalled.

2. Remove all resources from your groups.

3. Delete all groups.

4. Exit Oracle Fail Safe Manager.

Step 2  Invoke Oracle Universal Installer and deinstall software.
Invoke the Oracle Universal Installer and perform the following tasks:

1. Click Deinstall Products to display an Inventory dialog box.

2. Select the Oracle home that contains the Oracle Fail Safe release 3.n software.

3. Expand the tree view and select the check box next to Oracle Fail Safe 3.n.

4. Click Remove.

Step 3  Exit Oracle Universal Installer.
Click Exit to exit Oracle Universal Installer.

Perform the following steps to remove Oracle Fail Safe software.

Caution: You cannot deinstall a single component. If you select a 
single component to be deinstalled, all of Oracle Fail Safe will be 
deinstalled.

Note: Do not perform step 1 if you are moving Oracle Real 
Application Clusters Guard to a new Oracle home.
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4.2 Deinstalling Oracle Fail Safe Release 2.n Software
To deinstall Oracle Fail Safe release 2.0.5, 2.1.2, or 2.1.3, you must use Oracle 
Installer (the predecessor to Oracle Universal Installer). You cannot use Oracle 
Universal Installer to deinstall releases of Oracle Fail Safe that were installed with 
Oracle Installer.

Step 1  Remove all resources and delete all groups.
This step should be done only on groups that were configured with Oracle Fail Safe. 
Do not perform this step on groups that were configured with MSCS (such as the 
Cluster Group).

Using Oracle Fail Safe Manager, perform the following tasks:

1. Move each group to the node that will host the standalone resources after 
Oracle Fail Safe is deinstalled.

2. Remove all resources from your groups.

3. Delete all groups.

4. Exit Oracle Fail Safe Manager.

Step 2  Start Oracle Installer.
To start Oracle Installer, from the Windows taskbar choose Start -> Programs -> 
Oracle -> Oracle Installer. (If Oracle Installer is not available from the Start menu, 
you can access it on the Oracle Fail Safe CD-ROM in the \OracleInstall directory. 
Double-click Orainst.exe in the \OracleInstall directory to start Oracle Installer.)

This invokes Oracle Installer,  which is the installer that you must use to deinstall 
Oracle Fail Safe release 2.1.3 or earlier releases.

Step 3  Remove the Oracle Fail Safe components.
In the Oracle Installer Software Asset Manager dialog box, select Oracle Fail Safe 
Server, Oracle Fail Safe Manager, or both from the Installed Products window and 
click Remove to deinstall them.

Note: Do not perform step 1 if you are performing a rolling 
upgrade.
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Step 4  Unregister the Oracle Fail Safe resource DLL from MSCS.
Typically, you will click Yes when you are deinstalling the Oracle Fail Safe software. 
However, the following list provides more information to help you decide whether 
to answer Yes or No when you are prompted to unregister the Oracle resource from 
the cluster.

■ Click Yes to unregister the Oracle database resource and remove all Oracle Fail 
Safe information from the cluster database and registry. 

This option also unregisters the Oracle database resource type from MSCS. 
Choose this option when:

– You do not want to use Oracle Fail Safe on any cluster node

– You do not have any databases configured in an Oracle Fail Safe group on 
the cluster nodes

■ Click No to remove all Oracle Fail Safe files installed on this node without 
unregistering Oracle database resources and removing the Oracle database 
resource DLL files.

This option helps you to remove one node from the cluster while the other node 
or nodes continue to run Oracle Fail Safe. For example, you might choose this 
option if one node in the cluster fails or needs maintenance and you need to 
replace it with a different system, or if you are upgrading your Oracle Fail Safe 
software to release 3.3.1.

Step 5  Exit Oracle Installer.
Click Exit to exit Oracle Installer.



Troubleshooting Installation Problems 5-1

5
Troubleshooting Installation Problems

This chapter provides general information and helpful tips to help you troubleshoot 
problems with Oracle Fail Safe installations and deinstallations. The following table 
shows the information provided in this chapter:

5.1 Problems with the FSCMD Command After an Upgrade
If you upgraded from Oracle Fail Safe release 2.1.3.0 to release 3.n and suddenly 
your FSCMD scripts do not work, it is probably because you need to include the 
/Cluster parameter on the FSCMD command.

Beginning with release 2.1.3.1, the /Cluster parameter is required on the FSCMD 
command. If you upgraded from release 2.1.3.0, your FSCMD scripts will not work 
and you might get an "invalid number of parameters" error message on the FSCMD 
command.

Also, the FSCMD command is now located in <Oracle_Home>\fs\fsmgr\bin 
directory, where <Oracle_Home> is the Oracle Fail Safe home directory. If you have 
not set your directory to <Oracle_Home>\fs\fsmgr\bin, you must specify the full 
path when running the FSCMD command.

Topic Reference

Problems with the FSCMD Command After an Upgrade Section 5.1

Error Creating a Sample Database Section 5.2

Problems Installing Oracle Services for MSCS Section 5.3

Problems Deinstalling Oracle Fail Safe and MSCS Software Section 5.4

Problems with the User Rights Policy Section 5.5

Network Configuration Problems Section 5.6
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5.2 Error Creating a Sample Database
If you install a database server after installing Oracle Fail Safe and then you try to 
create a sample database, the following error message appears:

FS-10270 Oracle Fail Safe sample database files not found in installation 
directory or CD-ROM.

You can install the sample databases when you want to create a sample database. 
When Oracle8i, Oracle8, or Oracle9i software is installed and you issue the Create 
Sample Database command, Oracle Fail Safe checks to see if all necessary sample 
files are located in the Oracle home where you installed Oracle Fail Safe. If the 
sample database files are not in the Oracle home, Oracle Fail Safe checks to see if the 
Oracle Fail Safe release 3.3.1 CD-ROM is online. If Oracle Fail Safe finds the sample 
files in either the Oracle home or on the CD-ROM, the Create Sample Database 
operation will succeed. Otherwise, it will return an error message. You can install 
the sample database files in the same Oracle home where you install Oracle Fail 
Safe, or save disk space by leaving the sample database files on the CD-ROM.

See Chapter 2 for more information about installing sample database files.

5.3 Problems Installing Oracle Services for MSCS
If you are running Oracle Universal Installer on a system that does not have MSCS 
installed (such as a client system) and you try to install Oracle Services for MSCS, 
the installer will display an error such as that shown in Figure 5–1.

Figure 5–1 Error Window for Improper Server Installation
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If a message such as that shown in Figure 5–1 appears, do not continue with the 
installation. Click OK to back up through the installation windows and choose a 
Client Only installation (as described in Chapter 2).

5.4 Problems Deinstalling Oracle Fail Safe and MSCS Software
Chapter 4 warns against deinstalling the MSCS software before you deinstall Oracle 
Fail Safe. If you deinstall the MSCS software on all cluster nodes, the cluster 
metadata information about Oracle Fail Safe will be removed.

If you deinstall MSCS from only one cluster node, the cluster metadata information 
still is available on the other node or nodes. To prevent the loss of the cluster 
metadata, do not deinstall MSCS from the other nodes; reinstall MSCS on the first 
node and click Join an Existing Cluster when prompted by the installation 
procedure to add the node back to the cluster and recover the cluster metadata.

If you accidentally deinstall MSCS software on all cluster nodes before you deinstall 
Oracle Fail Safe, you can recover your Oracle databases (after you reinstall MSCS on 
all cluster nodes) by performing the following steps using Oracle Fail Safe Manager:

1. Select the standalone resource in the Oracle Fail Safe Manager tree view.

2. Select the Verify Standalone Database operation from the Resources menu.

3. Enter the standalone database information in the Verify Standalone Database 
window.

4. When the verification completes successfully, add the standalone resource to a 
group using the Add Resource to Group Wizard.

5.5 Problems with the User Rights Policy
For Oracle Services for MSCS to run, the "Log on as batch job" and "Log on as a 
service" user rights policy must be enabled for the user account under which Oracle 
Services for MSCS runs. Typically, the Oracle Fail Safe installation enables this 
policy for the user account during the security setup. However, in some situations, 
the user rights policy might not be enabled correctly on a backup domain controller 
(BDC), because the account database on the BDC is read-only and cannot be 
changed directly.

Note: It might be necessary to manually restore the configuration 
of other non-database resources, such as your Web server or 
application server.
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To solve the problem, perform these steps:

1. Perform one of the following operations:

■ If the primary domain controller (PDC) is part of the cluster, install Oracle 
Fail Safe on the PDC.

■ If the PDC is not part of the cluster, grant "Log on as batch job" and "Log on 
as a service" rights to the Oracle Services for MSCS user account on the 
PDC.

2. Synchronize the account database with the BDC (using the Server Manager 
administration tool).

3. Install Oracle Fail Safe on the BDC.

5.6 Network Configuration Problems
If you receive error messages regarding problems with the mapping of host names 
to IP addresses (such as FS-10514 and FS-10515), see the appendix on network 
configuration requirements in the Oracle Fail Safe Concepts and Administration Guide.
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A
Performing Rolling Upgrades

Oracle Fail Safe allows a cluster system to continue to provide service while the 
software is being upgraded to the next release. This process is called a rolling 
upgrade because each node is upgraded and rebooted in turn, until all server nodes 
and all client nodes have been upgraded. You might want to perform a rolling 
upgrade for the following reasons:

■ To upgrade the Oracle Fail Safe software or install patches

■ To upgrade other Oracle software and install patches that require you to stop 
the Oracle services being used by Oracle Fail Safe

This appendix discusses the following topics:

A.1 Preparing Users for the Upgrade
During a rolling upgrade, you need to perform a planned failover to make the 
cluster resources running on one node move over to another node. Each planned 
failover will disconnect users and cause rollback of any interrupted, uncommitted 
work.

Topic Reference

Preparing Users for the Upgrade Section A.1

Recommended Order for Upgrading Software Section A.2

Upgrading the Oracle Fail Safe Software and Installing Patches Section A.3

Upgrading Oracle Product Software Section A.4

Upgrading an Oracle Database Section A.5
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This brief outage typically is less than 1 minute and always is less than the 
downtime that would be experienced by users if Oracle Fail Safe was not installed. 
To prevent loss of work, notify users that you plan to shut down the system, and 
have all users commit their work and log off before you perform the failover. 
Advise users when they can reconnect and resume work after the database fails 
over to another cluster node.

While you are performing upgrades to a two-node cluster, remember that failback is 
disabled and your cluster is not protected against failures. In addition, each time 
that you stop and restart the cluster service on a node (with MSCS Cluster 
Administrator), all remaining cluster resources running on the node fail over to 
another node with a similar brief loss of service.

A.2 Recommended Order for Upgrading Software
The following list provides the recommended procedure for upgrading software on 
your cluster when just the database software or both the database software and 
Oracle Fail Safe software need to be upgraded.

1. Remove each database from its group.

2. Upgrade the Oracle database software and the Oracle Fail Safe software (if 
needed); the order in which you perform these two upgrades is not important.

3. Add each database back into its group.

If you are only performing an Oracle Fail Safe software upgrade (you are not going 
to upgrade the database software), then you do not need to remove any database 
from its group prior to performing the upgrade.

A.3 Upgrading the Oracle Fail Safe Software and Installing Patches
This section describes how to perform a rolling upgrade when you want to upgrade 
the Oracle Fail Safe software on a cluster that is currently running Oracle Fail Safe 
(for example, to upgrade the cluster from Oracle Fail Safe release 3.2.1 to release 
3.3.1). The tasks described in this section apply to upgrades from any Oracle Fail 
Safe release previous to Oracle Fail Safe release 3.3.1.

If you are performing a rolling upgrade of the Oracle Fail Safe software, you must 
upgrade the Oracle Services for MSCS and Oracle Fail Safe Manager software 

Note: This recommended order for upgrading software is 
different from previous releases of Oracle Fail Safe.
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clusterwide. You cannot run multiple releases of the Oracle Services for MSCS 
software on the same cluster. You can use Oracle Fail Safe Manager release 3.2.1 
with Oracle Fail Safe Server 3.1.1, 3.1.2, or Oracle Services for MSCS release 3.2.1 or 
3.3.1; however, you cannot run Oracle Fail Safe Manager release 3.2.1 or later with 
releases of Oracle Fail Safe Server prior to release 3.1.1.

When you upgrade the Oracle Fail Safe software, do not start the installation 
procedure while any Oracle Fail Safe Manager operations or MSCS Cluster 
Administrator operations are in progress on groups. You should wait for a quiet 
period in cluster operations before you proceed with the steps in Table A–1. 
Perform the steps described in Table A–1 on only one cluster node at a time.

Caution: To ensure minimal downtime and to identify any 
potential issues with other software that might be running on the 
cluster, Oracle Corporation recommends that you test the following 
upgrade operations on an identically configured test cluster before 
you upgrade the production cluster.

Table A–1 Steps Required to Upgrade to Oracle Fail Safe Release 3.3.1

Step Task Tool Comments

1 Change the group 
attributes to the 
Prevent Failback 
mode for all groups.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager 
online help. Changing the failback attributes prevents 
the group from failing back after its preferred node is 
being rebooted (later in step 6).

2 Perform a planned 
failover by moving 
groups (that contain 
Oracle databases) to 
another node.

Oracle Fail Safe 
Manager

Choose Groups -> Move to a Different Node. (See the 
instructions in the Oracle Fail Safe Help for more 
information.) By moving groups that include databases 
to another node, you can upgrade the current node 
while users continue to access the database on another 
node. When moving groups that contain databases 
with this method, Oracle Fail Safe will perform a 
checkpoint operation.

3 Exit Oracle Fail Safe 
Manager.

Oracle Fail Safe 
Manager

On the current node, select File -> Exit.

Note: Do not use Oracle Fail Safe Manager on other 
cluster nodes during the rest of the upgrade procedure 
until you run Verify Cluster in step 10. 
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4 Deinstall the 
previous release of 
Oracle Fail Safe 
Manager and Oracle 
Fail Safe Server.

Oracle Installer or
Oracle Universal 
Installer

See steps 2 through 5 in Section 4.2 for instructions.

Note: This step is required if your previous release of 
Oracle Fail Safe is release 2.1.3 or earlier. This step is 
optional if your previous release is release 3.n. You 
must follow this step if, for example, you plan to 
change the Oracle home location of Oracle Fail Safe.

5 Install Oracle Fail 
Safe release 3.3.1.

Oracle Fail Safe and 
Oracle Real Application 
Clusters Guard 
installation CD-ROM

You must install the same release of Oracle Fail Safe 
software on all server nodes. Follow the installation 
instructions in Chapter 2.

6 Reboot the node. Windows NT or 
Windows 2000

On the Windows taskbar, choose Start -> Shutdown 
-> Restart the Computer.

Note: You must wait until the first node is finished 
rebooting before you start installing Oracle Fail Safe on 
other nodes.

7 Move groups that 
contain Oracle 
databases to the 
upgraded node.

MSCS Administrator Move cluster groups that contain Oracle databases to 
the upgraded node.

Note: To avoid problems that can arise due to version 
mismatches, do not use Oracle Fail Safe Manager to 
perform this task; use MSCS Administrator.

8 Repeat steps 4 
through 6 on the 
other cluster node or 
nodes.

Various No comments.

9 Install Oracle Fail 
Safe Manager on 
client nodes.

Oracle Fail Safe and 
Oracle Real Application 
Clusters Guard 
installation CD-ROM

Oracle Fail Safe Manager release 3.3.1 can be used with 
any of the following Oracle Fail Safe and Oracle Real 
Application Clusters Guard releases: 

■ Oracle Fail Safe release 3.3.1, 3.2.1, 3.1.2, 3.1.1

■ Oracle Real Application Clusters Guard release 
3.3.1

10 Run the Verify 
Cluster operation.

Oracle Fail Safe 
Manager

This step verifies that there are no discrepancies in the 
software installation, such as with the release 
information on each node in the cluster, and registers 
resource DLLs.

Table A–1 (Cont.) Steps Required to Upgrade to Oracle Fail Safe Release 3.3.1

Step Task Tool Comments
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A.4 Upgrading Oracle Product Software
This section describes upgrading Oracle product software and installing patches 
that require you to stop the Oracle services being used by Oracle Fail Safe.

When you upgrade Oracle product software, do not start the installation procedure 
while any Oracle Fail Safe Manager operations or MSCS Cluster Administrator 
operations are in progress on groups. You should wait for a quiet period in cluster 
operations before you proceed with the steps in Table A–2. Perform the steps 
described in Table A–2 on only one cluster node at a time. Also, if you are 
upgrading Oracle database software, consider performing a database backup prior 
to any major upgrade.

11 Review the Verify 
Cluster Report.

Oracle Fail Safe 
Manager

If you are upgrading from certain releases (for example, 
release 2.1.3), the FS-10535 and FS-10538 warning 
messages are displayed in this report. If these messages 
are in the report, reboot each cluster node (one at a 
time), so that the changes to the resource DLL take 
effect on all cluster nodes. Then, rerun the Verify 
Cluster operation and confirm that these warnings are 
no longer included in the report.

12 Restore the failback 
policy attributes on 
the groups.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager 
online help to set the failback policy for all groups in 
the cluster.

13 Fail back groups, as 
necessary, by 
moving groups back 
to other nodes.

Oracle Fail Safe 
Manager

Perform planned failover operations to move each 
group back to its preferred node. This step redistributes 
the workload across the nodes in the cluster. Refer to 
the instructions in the Oracle Fail Safe Manager online 
help regarding moving a group to a different node.

14 Run the Verify 
Group operation on 
all groups.

Oracle Fail Safe 
Manager

Select Troubleshooting -> Verify Group to check all 
resources in all groups and confirm that they have been 
configured correctly. See the Oracle Fail Safe Concepts 
and Administration Guide for a description of the 
validation tests performed during a Verify Group 
operation.

Table A–1 (Cont.) Steps Required to Upgrade to Oracle Fail Safe Release 3.3.1

Step Task Tool Comments
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If your cluster is in an active/passive configuration, you can eliminate a failover if 
you start the rolling upgrade on the passive cluster node. Once you have finished 
the upgrade on the passive cluster node, you can skip to step 9 in Table A–2.

Caution: To ensure minimal downtime and to identify any 
potential issues with other software that might be running on the 
cluster, Oracle Corporation recommends that you test the following 
upgrade operations on an identically configured test cluster before 
you upgrade the production cluster.

Table A–2 Steps Required to Upgrade Oracle Product Software

Step Task Tool Comments

1 Change the group 
failback attributes to 
the Prevent Failback 
mode.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager online 
help. Changing the failback attributes prevents the group 
from failing back to the node while it is being rebooted or 
when the cluster service is restarted.

2 Perform a planned 
failover by moving 
groups to another 
node.

Oracle Fail Safe 
Manager

Choose Groups -> Move to a Different Node. (See the 
instructions in the Oracle Fail Safe Help for more 
information.) By moving all groups to another node, you can 
work on the current node. When moving groups that contain 
databases with this method, Oracle Fail Safe will perform a 
checkpoint operation.

3 Exit Oracle Fail Safe 
Manager.

Oracle Fail Safe 
Manager

On the current node, select File -> Exit.

4 Stop the cluster 
service on the node 
where you want to 
install software.

MSCS Cluster 
Administrator

In the left pane, click to select the cluster node where the 
cluster service needs to be stopped.

On the File menu, click Stop Cluster Service.

5 Stop all running 
Oracle applications 
and all remaining 
Oracle services.

Microsoft Control 
Panel

From the system taskbar choose Start -> Settings -> 
Control Panel, then:

■ On Windows NT:  double-click Services.

■ On Windows 2000:  double-click Administrative Tools, 
then Services.

Stop all running Oracle services, including the Oracle Fail 
Safe service.

6 Install the new 
Oracle product or 
component software.

Oracle Installer
or Oracle 
Universal 
Installer

Follow the instructions that come with the Oracle product or 
component.
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A.5 Upgrading an Oracle Database
If you need to upgrade a database that is configured in a group, you must first 
remove it from the group, perform the tasks necessary to upgrade the database to 
the new version, and then add it back into the group.

For information about database upgrades, refer to the Oracle Fail Safe Concepts and 
Administration Guide and to the upgrade instructions for Oracle Database Upgrade 
Assistant.

7 Reboot the node. Windows NT or 
Windows 2000

Rebooting the node automatically restarts the cluster service 
on the node where you just installed the Oracle software. 
Restarting the cluster service is essential for the changes to 
take effect.

8 Run the Verify 
Group operation on 
all groups.

Oracle Fail Safe 
Manager

Select Troubleshooting -> Verify Group to check all 
resources in all groups and confirm that they have been 
configured correctly. If you upgraded Oracle database 
software, the Verify Group operation will update the 
tnsnames.ora file. When prompted, click Yes. Otherwise, the 
Oracle database might not come online after you add it to a 
group.

9 Repeat steps 2 
through 8 on the 
other server node or 
nodes in the cluster.

Various No comments.

10 Run the Verify 
Cluster operation.

Oracle Fail Safe 
Manager

This step verifies that there are no discrepancies in the 
software installation, such as with the release information on 
each node in the cluster.

11 Restore the failback 
policy attributes on 
the groups.

Oracle Fail Safe 
Manager

Follow the instructions in the Oracle Fail Safe Manager online 
help to set the failback policy for all groups in the cluster.

12 Fail back groups, as 
necessary, by 
moving groups back 
to the other node or 
nodes.

Oracle Fail Safe 
Manager

Perform a planned failover to move the groups back to the 
preferred node. This step rebalances the workload across the 
nodes in the cluster. Refer to the instructions in the Oracle 
Fail Safe Manager online help regarding moving a group to a 
different node.

Table A–2 (Cont.) Steps Required to Upgrade Oracle Product Software

Step Task Tool Comments
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B
Performing a Silent Installation

This appendix describes how to automate the Oracle Fail Safe installation by 
performing a silent installation.

The following topics are discussed in this appendix:

B.1 Introduction to Silent Mode Installations
You can install Oracle Fail Safe in silent mode, which is an installation method that 
allows you to install software by supplying input to Oracle Universal Installer in a 
file, rather than through the Oracle Universal Installer graphical user interface 
(GUI). 

If you are performing multiple installations that are identical or similar to each 
other, you may want to run Oracle Universal Installer in silent mode to automate 
the installation process. You do this by editing a file, called a response file, that is 
supplied with Oracle Fail Safe.

A response file contains the answers that you typically provide in an interactive 
installation session. By providing all installation input in a response file, which you 
invoke at the command-line prompt or in batch mode, you eliminate the need for 
direct interaction from the user, and a GUI is not displayed. 

You can use the same response file multiple times. However, each installation uses 
only one response file. 

Topic Reference

Introduction to Silent Mode Installations Section B.1

Editing and Enabling the Response File Section B.2

Contents of a Response File Section B.3
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To perform a silent installation with a response file, use the command-line mode or 
a batch script to invoke Oracle Universal Installer and enable the response file.

A silent installation is the only alternative to using the Oracle Universal Installer 
GUI; there is no character-mode version of Oracle Universal Installer.

B.2 Editing and Enabling the Response File
Three different response file templates are available on the Oracle Fail Safe 
CD-ROM to help you set up Oracle Fail Safe installations in silent mode. Each 
template file performs a different type of installation. In the Oracle Universal 
Installer, you would choose an installation type through the screen shown in 
Figure 2–4; in a silent installation, you choose a response file template that 
corresponds to the desired installation type.

The template files are located on the CD-ROM in the \stage\Response directory. 
Sample response files have also been provided.

The template files, samples, and their corresponding installation types are listed in 
the following table:

B.2.1 Implementation Steps
The following steps describe how to customize the variables in a response file and 
enable Oracle Universal Installer to use the file. 

Note: You cannot use response files to reinstall Oracle Fail Safe. If 
you need to reinstall Oracle Fail Safe, you must use the Oracle 
Universal Installer interface to perform the reinstallation, or use the 
Oracle Universal Installer interface to first deinstall Oracle Fail Safe 
and then use response files to install the software again.

Template Name Sample Name Installation Type

oracle.failsafe.complete.typical.rsp failsafe.typical.rsp Typical installation1

1 The Typical installation type installs all of the Oracle Fail Safe components.

oracle.failsafe.complete.client.rsp failsafe.client.rsp Client Only installation

oracle.failsafe.complete.custom.rsp failsafe.custom.rsp Custom installation
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Step 1  Copy the response file template from the CD-ROM.
Make a copy of the original response file templates (located on the CD-ROM in the 
\stage\Response directory) to use as the basis for your response file. Retain the 
original files for use as templates.

You might want to make several copies of a response file, each with a different 
purpose, and specify a different name for each one. For example, you might have a 
response file named failsafemanager.rsp that performs only Oracle Fail Safe 
Manager installations.

Step 2  Edit the response file.
Edit the response file to specify options for your Oracle Fail Safe installation.

The response file templates contain all of the required Oracle Fail Safe installation 
variables for the corresponding installation type. There are variables that specify the 
name of the Oracle home where you want to install Oracle Fail Safe, the installation 
type (Typical, Custom, or Client Only), and the account user name and password 
for the Oracle Fail Safe service.

In the response files, each variable is documented using comment lines that begin 
with a number sign (#). The comments contain information about the type of the 
variable, whether the variable is displayed in a dialog box, and the function of the 
variable. 

The following sections describe how to perform the installations. Except where 
noted, the variables have the same behavior in each of the three response file 
templates. The variables used in the following sections are also documented in 
Table B–1 and Table B–2.

For All Installation Types: Edit the following variables to specify the name of the 
Oracle home where you want to install Oracle Fail Safe:

Note: Use a response file only to perform silent installations for 
Oracle Fail Safe. Do not use the response files that are provided 
with Oracle Fail Safe to install any other products.

Note: Before editing the response file, read Section B.3, which 
contains important information about editing the variables in the 
response file.
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ORACLE_HOME

ORACLE_HOME_NAME

For a Typical Installation: To install all of the Oracle Fail Safe components:

1. Use the oracle.failsafe.complete.typical.rsp response file template.

2. Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.3.1.0.0] 
Component section and make sure the value is INSTALL_TYPE="Typical" (this 
is the default setting).

3. Locate the DomainUserName and Pwd variables at the end of the file. Edit 
these variables with the account domain, user name, and password needed by 
Oracle Fail Safe.

For a Client Only Installation: To install Oracle Fail Safe Manager only:

1. Use the oracle.failsafe.complete.client.rsp response file template.

2. Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.3.1.0.0] 
Component section and make sure the value is INSTALL_TYPE="install_type_
1" (this is the default value).

For a Custom Installation: To perform a customized installation of Oracle Fail 
Safe:

1. Use the oracle.failsafe.complete.custom.rsp response file template.

2. Locate the INSTALL_TYPE variable in the [oracle.failsafe.complete_3.3.1.0.0] 
Component section and make sure the value is INSTALL_TYPE="Custom" (this 
is the default value).

3. Locate the DomainUserName and Pwd variables at the end of the file. Edit 
these variables with the account domain, user name, and password needed by 
Oracle Fail Safe.

4. Specify the components to be installed in the DEPENDENCY_LIST variable.

Step 3  Invoke Oracle Universal Installer in silent mode.
On each system where you want to install Oracle Fail Safe, invoke Oracle Universal 
Installer using the following command syntax at the command-line prompt or in a 
batch file:

E:\stage\Disk1\install\setup.exe -responseFile filename 
-silent -nowelcome
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In the example, E: is the drive letter for the CD-ROM. The following list explains the 
syntax in the command line:

■ setup.exe invokes Oracle Universal Installer.

■ -responseFile indicates that you are supplying a response file for this 
installation.

■ filename  specifies the full path name of the response file that you want to use 
to provide input to Oracle Universal Installer.

■ -silent indicates that you want to run Oracle Universal Installer in silent 
mode.

■ -nowelcome is an optional command parameter that suppresses the welcome 
dialog that typically displays during an installation. 

For example, the following command performs an Oracle Fail Safe installation in 
silent mode by reading all required installation information from the 
failsafemanager.rsp file:

E:\stage\Disk1\install\setup.exe -responseFile C:\failsafemanager.rsp -silent -nowelcome

Step 4  Delete the response file or move it to a secure location.
Because the response file specifies the domain, user name, and password 
information in the DomainUserName and Pwd variables, make sure that you either 
delete the response file or move it to a secure location on your system after the 
installation completes.

B.2.2 Validation of Values from the Response File
During an installation session when a variable is initialized, Oracle Universal 
Installer reads the response file to see if a value has been assigned for the variable. 
Oracle Universal Installer retrieves and uses values from the response file according 
to the conditions described in the following list:

■ If the response file does not contain values for one or more required variables, 
then Oracle Universal Installer stops the installation.

■ If any variable that is specified in the response file contains invalid content, 
format, or type value, then Oracle Universal Installer ignores the specified 
value.

■ If any variable is specified outside of a response file section, then Oracle 
Universal Installer ignores the variable.



Contents of a Response File

B-6 Oracle Fail Safe Installation Guide

B.2.3 silentInstall.log File
When you perform a silent installation, the success or failure of the installation is 
recorded in a file named silentInstall.log. The file is located in the Oracle installation 
log area, such as C:\Program Files\Oracle\Inventory\logs.

Oracle Universal Installer does not write to the log file until after the silent 
installation has completed.

B.3 Contents of a Response File
The rest of the sections in this appendix describe the contents of the response file 
templates that are provided with Oracle Fail Safe. Edit the variables in your copy of 
the file to contain the responses you would need to provide during the Oracle Fail 
Safe installation session. Use the following format when you specify values for 
variables in the response file:

variable name = <recommendation> : value

Set the variable name and value parameters as described in Table B–1 and Table B–2. 
Set the optional <recommendation> variable to either Forced or Default, as follows:

■ Forced—does not display the setting for the value parameter during installation; 
the user cannot change any variable values during the silent installation.

■ Default—displays the default setting for the value parameter during the 
installation and allows the user to choose another value.

Each response file contains at least three sections: General, Session, and one or more 
Component sections. Each section begins with a line that specifies the section name 
in brackets (for example, the General section begins with [General]).

B.3.1 General Section
The General section is an informational section that contains the version number of 
the response file. There is only one General section per response file. For example:

[General]
RESPONSEFILE_VERSION=1.7.0

Do not edit information in the General section.
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B.3.2 Session Section
The Session section lists predefined (generic) dialogs for Oracle Universal Installer 
and shows whether the dialogs are visible to the user.

Oracle Universal Installer displays the dialog when the value is set to true, and does 
not display the dialog when a value is set to false. For example:

[SESSION]
SHOW_INSTALL_PROGRESS_PAGE=true

Because the SHOW_INSTALL_PROGRESS_PAGE is set to true, the progress of the 
installation will be displayed during the installation. The Session section also lists 
global variables that are set during one installation session (from the start of the 
installation to the end of installation). These variables include top-level components 
and languages. 

Table B–1 provides a list of the variables in the Session section.

Note: This section is relevant only if you do not specify the -silent 
qualifier on the command line. The -silent qualifier overrides all of 
the variable values in the Session section and does not display any 
of the installation dialog boxes.

Table B–1 Variables for the Session Section 

Variable Name Value Type Required?

FROM_LOCATION Specifies the "From" location in the installer, 
which is a directory path containing the source 
of the products to be installed.

String Yes

FROM_LOCATION_CD_LABEL Specifies the label of the CD-ROM where the 
products.jar file exists. The label can be found 
in the file "disk.label" in the same directory as 
products.jar. This variable should be used only 
in multi-CD-ROM installations.

String No

NEXT_SESSION Set to true to allow users to go back to the File 
Locations page for another installation. If you 
want to process another response file, this flag 
must be set to true.

Boolean No
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NEXT_SESSION_ON_FAIL Set to true to allow users to invoke another 
session even if the current installation has 
failed. This variable is relevant only if NEXT_
SESSION is set to true.

Boolean Yes

NEXT_SESSION_RESPONSE Optionally specifies the full path of the 
response file for the next session. If only a file 
name is specified, the response file is retrieved 
from the <TEMP>\OraInstall directory. This 
variable is active only if NEXT_SESSION is set 
to true.

String No

ORACLE_HOME Specifies the "To" location in the installer 
where products are to be installed. For 
example, "C:\OFS" (use quotation marks).

String Yes

ORACLE_HOME_NAME Specifies the name of the current Oracle home. 
For example, "OracleFailSafe" (use quotation 
marks).

String Yes

SHOW_COMPONENT_LOCATIONS_
PAGE

Allows you to specify an alternate directory 
location for the installation. Specify false to 
prevent users from changing the location of 
the installation directory.

Boolean No

SHOW_CUSTOM_TREE_PAGE Displays only during a custom installation. On 
this page, dependencies can be selected or 
deselected. Set the value to true if you want to 
show the custom tree page in the installer and 
allow dependencies to be selected or 
deselected. Specify false to suppress it.

Boolean No

SHOW_END_SESSION_PAGE Displays the install success/failure page at the 
end of an installation. Set the value to true to 
show the page. Specify false to suppress it.

Boolean Yes

SHOW_EXIT_CONFIRMATION Set to true to show confirmation when exiting 
the installer. Specify false to suppress it.

Boolean No

SHOW_INSTALL_PROGRESS_PAGE Displays the current status (including which 
product is being installed and which file is 
being copied) during the installation. Set the 
value to true to show the current status. 
Specify false to suppress it.

Boolean No

Table B–1 (Cont.) Variables for the Session Section 

Variable Name Value Type Required?
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B.3.3 Component Section of the Response File
The response file can contain one or more of the following Oracle Fail Safe 
component sections:

[oracle.failsafe.complete_3.3.1.0.0]
[oracle.failsafe.server_3.3.1.0.0]

SHOW_OPTIONAL_CONFIG_TOOL_
PAGE

Displays the optional configuration tools that 
are a part of this installation, including the 
status of each tool and any tool failures that 
were detected. Set the value to true to show 
the page. Specify false to suppress it.

Boolean No

SHOW_RELEASE_NOTES Displays the list of release notes available for 
the products just installed. Set to true to show 
the release notes at the end of the installation. 
Specify false to suppress the list.

Boolean No

SHOW_REQUIRED_CONFIG_TOOL_
PAGE

Displays the required configuration tools that 
are a part of this installation, including the 
status of each tool and any tool failures that 
were detected. Set the value to true to show 
the page. Specify false to suppress it.

Boolean No

SHOW_ROOTSH_CONFIRMATION Not applicable (NA). NA NA

SHOW_SPLASH_SCREEN Set to true if the initial splash screen for the 
Oracle Universal Installer needs to be shown.

Boolean No

SHOW_SUMMARY_PAGE Lists the components that will be installed in 
this session. Set this value to true to display 
the summary page during the silent 
installation. Specify false to suppress it.

Boolean Yes

SHOW_WELCOME_PAGE Set to true if the welcome page in the installer 
needs to be shown.

Boolean No

TOPLEVEL_COMPONENT Specifies the name of the Oracle Fail Safe 
component and version as a string list. Specify 
the components as a pair of strings: the first 
one represents the internal name and the 
second represents the version. For example, 
{"oracle.failsafe.complete","3.3.1.0.0"}.

Stringlist Yes

UNIX_GROUP_NAME Not applicable (NA). NA NA

Table B–1 (Cont.) Variables for the Session Section 

Variable Name Value Type Required?
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To find a value for a variable, Oracle Universal Installer checks the appropriate 
component section to which the variable belongs. All variables are required for the 
files in which they appear. Table B–2 describes the variables.

Table B–2 Variables for the Component Section

Variable Name Value Type

DomainUserName Enter the domain and user name for an account (entered as 
domain\username) that has Administrator privileges. For example:

DomainUserName="OFSDomain\smith"

This variable appears in response files for Custom and Typical 
installations.

String

Pwd Enter the password for the account you specified with the 
DomainUserName variable. For example:

Pwd="myadminpassword"

This variable appears in response files for Custom and Typical 
installations.

String

DEPENDENCY_LIST Specifies the dependent components that you want to install with Oracle 
Fail Safe. You specify the list of components using an internal name and 
version number. For example, the value can contain any combination of 
the following components:

DEPENDENCY_LIST=
{"oracle.failsafe.server","3.3.1.0.0",
"oracle.failsafe.manager","3.3.1.0.0",
"oracle.mscs.server","3.3.1.0.0",
"oracle.swd.oui","1.7.0.18.0a"}

This variable appears in response files for only the Custom installation.

Stringlist

INSTALL_TYPE Specify the internal name for only one of the following installation types:

■ The internal name for a Typical installation is Typical.

■ The internal name for a Custom installation is Custom.

■ The internal name for a Client Only installation is install_type_1.

For example: INSTALL_TYPE="install_type_1"

This variable appears in all response files.

String

OPTIONAL_CONFIG_
TOOLS

Specifies the security configuration tool to be started when you install 
Oracle Services for MSCS. Specify it using the internal name and external 
name, as follows:

OPTIONAL_CONFIG_TOOLS={"configtool1"}

This variable appears in response files for only the Typical installation.

Stringlist
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C
Manually Registering Oracle Resource DLL

Files

Oracle Fail Safe provides resource dynamic-link library (DLL) files for the Oracle 
database server and Oracle TNS Listener. The DLL files enable the Cluster Service 
to communicate and manage the Oracle database and listener resources. Other 
Oracle resources that do not require specialized DLL files, such as Oracle Forms and 
Reports, are managed as Generic Services.

The following topics are discussed in this appendix:

C.1 Oracle Resource DLL Files
Oracle Services for MSCS includes the resource DLL files shown in Table C–1. These 
files enable MSCS to communicate with and manage the Oracle resource types.

Topic Reference

Oracle Resource DLL Files Section C.1

Registering and Unregistering the Oracle Resource DLL Files Section C.2
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■ How often MSCS should poll the Oracle resource health (Looks Alive, Is Alive 
polling intervals)

■ Whether a database resource should be restarted when it fails, and, if so, how 
many times MSCS should attempt to restart it before failing over to the other 
node

■ How long MSCS should wait before declaring failure of the database resource 
(pending timeout) during the startup and shutdown of the resource

If the database resource takes longer than the time you specified with the 
pending timeout parameter to come online or go offline and the resource DLL 
did not detect any problems in the online or offline process, the resource DLL 
asks MSCS to give it more time to complete the process. Thus, you do not have 
to be concerned if a resource occasionally takes longer to come online or go 
offline.

C.2 Registering and Unregistering the Oracle Resource DLL Files
Typically, the Oracle Fail Safe Verify Cluster operation automatically verifies the 
Oracle database resource DLL files and their registration with the MSCS software. If 
the Verify Cluster operation finds that the DLL files are not registered, it registers 

Table C–1  Oracle Resource DLL Files

File Type Description

FsResOdbs.dll Oracle database, Oracle TNS 
Listener, and Oracle 
resource type DLL file

Provides functions to allow the cluster to bring an 
Oracle resource online or offline and check the 
health of the resource through Is Alive polling. 
When the resource is online, the Oracle resource 
DLL guarantees that the resource is accessible by the 
client. Otherwise, the Is Alive polling fails.

FsResOdbsEx.dll Oracle database resource 
administration extension 
DLL file

Used by MSCS Cluster Administrator to display the 
properties of the Oracle database resource.

FsResTnsLsnrEx.dll Oracle TNS Listener 
resource extension DLL file

Used by MSCS Cluster Administrator to display the 
properties of the Oracle TNS Listener resource.

Note: If MSCS is unable to bring an Oracle database resource 
online, or if the Is Alive polling fails, the Oracle resource DLL logs a 
Windows event under the OracleMCSServices source to indicate 
the reason.
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them with the MSCS software. Using the Verify Cluster operation is the preferred 
method for registering DLL files.

However, if you find that the Oracle resource DLL files are not registered properly, 
you can use the commands in Section C.2.1 and Section C.2.2 to manually register or 
unregister them.

C.2.1 Oracle Resource DLL Files
To register the Oracle database resource DLL files, use the following commands:

fssvr /register "Oracle Database" FsResOdbs.dll
fssvr /register "Oracle TNS Listener" FsResOdbs.dll

To unregister the Oracle database resource DLL files, use the following command:

fssvr /unregister "Oracle Database"
fssvr /unregister "Oracle TNS Listener"

C.2.2 Oracle Resource Administrator Extension DLL Files
To register the Oracle database resource administrator extension DLL files on the 
cluster nodes, use the following commands:

fsregadm /r FsResOdbsEx.dll
fsregadm /r FsResTnsLsnrEx.dll

To unregister the Oracle database resource administrator extension DLL files on the 
cluster nodes, use the following commands:

fsregadm /u FsResOdbsEx.dll
fsregadm /u FsResTnsLsnrEx.dll

If MSCS Cluster Administrator is installed on a node that is not a member of a 
cluster, you need to register the Oracle database resource administrator extension 
DLL with the cluster so that you can view Oracle database resource parameters 
from the MSCS Cluster Administrator. To register, use the fsregadm command. You 
must issue the command from the bin directory where Oracle Fail Safe Manager is 
installed (because Oracle Fail Safe Manager is not in the path environment 
variable).

For example:

fsregadm /r /c Cluster1 FsResOdbsEx.dll
fsregadm /r /c Cluster1 FsResTnsLsnrEx.dll
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You must specify the cluster name with the /c option or the command will fail.



Index-1

Index
A
adding

a new node to the cluster, 1-5
administration

deinstalling software on a cluster, 4-1
installing Oracle Fail Safe, 2-1
registering Oracle resource DLLs, C-1
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before you install checklist, 2-1
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CD-ROM media

storing sample database files, 2-9, 5-2
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before you install, 2-1
cluster setup, 1-2
installation order, 1-3
preinstallation of Oracle Fail Safe software, 2-1

Client Only installation, 2-7
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template file, B-2

clients
preparing for rolling upgrades, A-1
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connecting to, 1-7
pinging, 1-3, 1-6
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cluster disks
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Oracle Services for MSCS and, 3-8
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connecting to, 3-3
insufficient space, 2-12
order of software installations, 1-3, 1-5
pinging, 1-3, 1-6
reboot, 2-15
removing from registry, 4-4
setting up, 1-2
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stopping cluster service on, A-5
upgrading software on, A-1
verifying, 3-5
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Cluster parameter
FSCMD command parameter, 5-1

cluster systems
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Component section
response file, B-9

components
installing, 2-7
showing a summary page during silent 

installation, B-9
specifying dependencies in a response file, B-10
specifying top level in a response file, B-9

configuration tools
optional, B-9
required, B-9

Connect to Oracle Fail Safe Cluster dialog box, 3-3
conventions used in this guide, 1-2
Custom installation, 2-7, B-10

sample file, B-2
template file, B-2

D
databases

installing sample files, 2-9, 5-2
moving to a new Oracle home, A-5
rolling upgrades, A-5
sample database files on CD-ROM, 2-9

deinstallations
Microsoft Cluster Server (MSCS) software, 4-1
Oracle Fail Safe release 2.n, 4-3
Oracle Fail Safe release 3.0, 4-1
reasons for, 4-1
steps, 4-2
troubleshooting, 5-3

DEPENDENCY_LIST variable, B-10
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for Oracle Fail Safe installations, 2-4
disk devices

during preliminary cluster setup, 1-2
insufficient space for installations, 2-12
private and cluster installations, 1-4

DLL files

FsResOdbs.dll, C-2
FsResOdbsEx.dll, C-2
FsResTnsLsnrEx.dll, C-2
Oracle resources, C-1
registering manually, C-1
registering Oracle resource administrator, C-3
registering Oracle resources, C-3
registration, C-2
unregistering Oracle resource 

administrator, C-3
unregistering Oracle resources, C-3

domain
connecting to cluster, 3-4
log on to install Oracle Fail Safe, 2-2
user account for Oracle Fail Safe, 2-13

domain name
specifying in a response file, B-10

DomainUserName variable, B-4, B-10
dynamic-link library (DLL) files

See DLL files

E
errors

See troubleshooting
events

logging OracleMSCSServices in Windows, C-2
executable application files

installing, 1-6

F
failback policy, A-5, A-7
failover

planned, A-5, A-7
File Locations dialog box, 2-4
FROM_LOCATION variable, B-7
FROM_LOCATION_CD_LABEL variable, B-7
FSCMD command

scripts require Cluster parameter, 5-1
FsResOdbs.dll file

functions, C-2
registering, C-3
unregistering, C-3

FsResOdbsEx.dll file
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functions, C-2
registering, C-3
unregistering, C-3

G
General section

response file, B-6
groups

removing resources from before 
deinstallation, 4-2

H
Help

invoking Oracle Fail Safe tutorial with, 1-7
Oracle Fail Safe Manager, 3-10

host names
mapping to IP addresses, 5-4

I
INSTALL_TYPE variable, B-10

Custom value, B-4, B-10
install_type_1 value, B-4, B-10
Typical value, B-4, B-10

installations
alert and trace files, 1-6
application data, 1-6
executable application files, 1-6
log files, 1-6
multiple Oracle homes, 2-5
Oracle Fail Safe, 2-1 to 2-15
preparation for, 1-1
progress page, B-8
recommended order for software, 1-2
sample database files, 2-9
selecting components for a silent 

installation, B-8
silent mode, B-1
trace files, 1-6
troubleshooting MSCS, 5-1
types, 2-7, B-10
Web server components, 2-8
See also Oracle Installer, Oracle Universal Installer

installing
application software, 1-4
Oracle database server software, 1-4

IP addresses
mapping to host names, 5-4
pinging, 1-3, 1-6

Is Alive polling
DLL file function, C-2
failure, C-2

L
log files

installing on a cluster, 1-6
silent installation, B-6

M
managing Oracle Fail Safe, 3-3
Microsoft Cluster Server

See MSCS
Microsoft hardware compatibility list, 1-2
Microsoft Windows

installation, 1-5
recommended order for installation, 1-5

Microsoft Windows 2000
installation, 1-3
logging OracleMSCSServices events, C-2
recommended order for installation, 1-3

Microsoft Windows NT Enterprise Edition
installation, 1-3
logging OracleMSCSServices events, C-2
recommended order for installation, 1-3

MSCS
deinstallation, 4-1 to 4-4
installation, 1-3, 1-5
Is Alive polling, C-2
prerequisites for installing, 1-2
recommendation for installation, 1-3
troubleshooting

deinstallations, 5-3
unable to bring Oracle resource online, C-2

MSCS Cluster Administrator, C-3
displaying Oracle database resource properties 

with, C-2
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displaying Oracle TNS Listener resource 
properties with, C-2

Oracle Services for MSCS resource in Cluster 
Group, 3-8

starting, 3-8
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network configuration

troubleshooting, 5-4
new nodes

adding to a cluster, 1-5
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online help, 3-10
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Oracle database resource DLL files, C-2
Oracle database server software
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for Oracle Fail Safe installations, 2-4
installing application software and, 1-4
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Oracle Installer, 4-3
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planned failover, A-5, A-7
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for installing MSCS, 1-2
for installing Oracle Fail Safe, 2-1

private disks
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for Oracle Fail Safe installations, 2-4
software and file installations, 1-4
trace files on, 1-6
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rebooting
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extension DLL file, C-2

Oracle database resource DLL files, C-2
Oracle resource administrator DLL files, C-3
Oracle resource DLL files, C-2, C-3
Oracle resource DLL files on noncluster 

nodes, C-2
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DLL files, C-2
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contents of, B-6
editing, B-3
General section, B-6
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making a copy, B-3
Session section, B-7
use in silent installations, B-1
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validating variable values in, B-5
rolling upgrades

See upgrades
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domain user account for Oracle Fail Safe, 2-13
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verifying OracleMSCSServices service entry, 3-7

Services Control Panel
startup status for Oracle Fail Safe, 3-7
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response file, B-7
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setup.exe program
starting Oracle Installer, 4-3
starting Oracle Universal Installer, B-5

shared storage devices
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response file definition, B-1
status logged in silentInstall.log file, B-6
Typical installation, B-10

silentInstall.log file, B-6
software installations and upgrades, A-1

preparing cluster for, 1-2
recommended order, 1-2

source directory
location of Oracle Fail Safe installation files, 2-5

space requirements
for installations, 2-12

starting
MSCS Cluster Administrator, 3-8
Oracle Fail Safe Manager, 3-1
Oracle Installer, 4-3
Oracle Universal Installer, B-4
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TCP/IP network protocol

support, 1-2
TCP/IP network transport

pinging network connections, 1-3, 1-5
templates

for response files, B-2
tnsnames.ora file

checking Oracle Net configuration data, 1-2
updating, A-7

TOPLEVEL_COMPONENT variable, B-9
trace files

location, 1-6
troubleshooting

FS-10514 error message, 5-4
FS-10515 error message, 5-4
FSCMD scripts, 5-1
installations, 5-1, 5-2
MSCS installations, 5-1
network configuration problems, 5-4
Oracle Fail Safe and MSCS deinstallations, 5-3
Oracle Services for MSCS installations, 5-2
sample database creation, 5-2
user rights policy, 5-3

tutorial, 3-10
for Oracle Fail Safe Manager, 3-10
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invoking, 1-7
Typical installation, 2-7

sample file, B-2
template file, B-2
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UNIX group name

specifying in a response file, B-9
UNIX_GROUP_NAME variable, B-9
unregistering

Oracle Fail Safe from Windows registry, 4-4
Oracle resource administrator DLL files, C-3

upgrades
from release 2.1.3 or earlier, A-2
installing other Oracle products, A-5
of Oracle Fail Safe, A-3
of other Oracle products, A-6
order of, A-2
performing, A-1
preparing users for, A-1
rolling, A-1
testing, A-3, A-5
troubleshooting, 5-1

user name
specifying in a response file, B-10
supplying when connecting to cluster, 3-4

V
variables

assigning values to, B-5
in Session section of response file, B-7

Verify Cluster operation
running after installation, 1-7, 3-5

Verify Group operation, A-5

W
Web server

installing components for, 2-8
Windows 2000

See Microsoft Windows 2000
Windows NT

See Microsoft Windows NT Enterprise Edition


	Contents
	List of Figures
	List of Tables
	Send Us Your Comments
	Preface
	Intended Audience
	Documentation Accessibility
	Structure
	Related Documents
	Conventions
	Documentation Sales

	1 Introduction and Preinstallation Checklist
	1.1� Conventions
	1.2� Cluster Setup Prerequisites
	1.3� Recommended Order for Software Installation
	1.4� Adding a Node to an Existing Cluster
	1.5� Postinstallation Procedures

	2 Installing Oracle Fail Safe
	2.1� Review the Before You Install Checklist
	2.2� Install the Oracle Fail Safe Software

	3 Getting Started
	3.1� Starting the Manager and Verifying the Oracle Fail Safe Installation
	3.1.1� Start Oracle Fail Safe Manager
	3.1.2� Connect to the Cluster
	3.1.3� Run Verify Cluster
	3.1.4� Verify the OracleMSCSServices Service Entry
	3.1.5� Verify That Oracle Services for MSCS Is in the Cluster Group
	3.1.6� Verify That Oracle Resource DLLs Were Registered with MSCS

	3.2� Oracle Fail Safe Manager Tutorial and Online Help

	4 Deinstalling Software on a Cluster
	4.1� Deinstalling Oracle Fail Safe Release 3.n Software
	4.2� Deinstalling Oracle Fail Safe Release 2.n Software

	5 Troubleshooting Installation Problems
	5.1� Problems with the FSCMD Command After an Upgrade
	5.2� Error Creating a Sample Database
	5.3� Problems Installing Oracle Services for MSCS
	5.4� Problems Deinstalling Oracle Fail Safe and MSCS Software
	5.5� Problems with the User Rights Policy
	5.6� Network Configuration Problems

	A Performing Rolling Upgrades
	A.1� Preparing Users for the Upgrade
	A.2� Recommended Order for Upgrading Software
	A.3� Upgrading the Oracle Fail Safe Software and Installing Patches
	A.4� Upgrading Oracle Product Software
	A.5� Upgrading an Oracle Database

	B Performing a Silent Installation
	B.1� Introduction to Silent Mode Installations
	B.2� Editing and Enabling the Response File
	B.2.1� Implementation Steps
	B.2.2� Validation of Values from the Response File
	B.2.3� silentInstall.log File

	B.3� Contents of a Response File
	B.3.1� General Section
	B.3.2� Session Section
	B.3.3� Component Section of the Response File


	C Manually Registering Oracle Resource DLL Files
	C.1� Oracle Resource DLL Files
	C.2� Registering and Unregistering the Oracle Resource DLL Files
	C.2.1� Oracle Resource DLL Files
	C.2.2� Oracle Resource Administrator Extension DLL Files


	Index

